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[bookmark: _heading=h.1t3h5sf]Month

Thursday, September 20, 2018
To Do:
1. Explain lab notebook formatting
2. Media prep
Results and Data:
For each day, copy the previous entry headers and update the date. Save the same ongoing copy of the lab notebook to the lab google drive ONLY. Do not save separate physical copies. At the 1st of each new month, a read-only PDF file of the lab notebook must be saved and given to Dr. Ramsey electronically. 

File contents converted to PDF MUST NOT BE EDITED after PDF conversion. Continue to keep using the same word file until the end of the calendar year. New lab notebook files run in 6 month intervals. 
For the To do list, update this each day with new tasks, as tasks are done, use the strikethrough font on the day they are completed and leave them out of the list on the next day.
[image: ]
[bookmark: _heading=h.4d34og8]Figure 1
Figures are inserted as inline .png files when possible, .jpg, .gif, .tif otherwise are acceptable. Figure legends are always inserted in Word (right click – ‘insert caption’) and use “Heading 2” text to properly format in the TOC. Table legends are handled the same way. Figure images must be saved in a separate folder where the source data is saved. 

Thoughts or questions. When you have a significant observation, question, confusing point or contradiction that you have identified in your data or protocol, use the “Heading 3” text heading on a descriptive brief title or single word heading so you can refer to it in your TOC later. 
[bookmark: _heading=h.2s8eyo1]Protocol 1
1. This is the format for a protocol in your notebook. 
2. The protocol title must be formatted in “Heading 2.”
3. Reagents which must be made for a specific protocol (buffers, solutions) should be listed in a “Reagents” Section, formatted in “Heading 3.”
4. The protocol must be in numerical steps.
5. Use standard notation and carefully describe units for your protocol.
6. Use ½” indent for protocol text. 
[bookmark: _heading=h.17dp8vu]Reagents
	Specific buffers 
For initial lab notebooks, write as much detail as possible. As time goes by you will be able to refer to written protocols by their heading and/or page number within the document. If you make any modifications to a protocol you must state how and why. 
[bookmark: _heading=h.3rdcrjn]File Formatting Protocol
1. Filenames begin with your initials, an underscore, and the date, formatted as the last 2 digits of the year, the month, then the day, ex: “KMR_180920_Sample_file1v1.xls” 
2. This ensures all files will be sorted by their creator and by their date. You must use this file formatting system for all data files (including photos) that will be shared with the lab. 
Bibliography data will be saved as (author/date) and using Mendeley at this time with the TOC inserted by order cited at the end of the lab notebook in the Bibliography section. 
Example is a recent publication (Ramsey and Dove, 2016).




[bookmark: _heading=h.26in1rg]October 2023

Tuesday, October 10 2023
To Do:
1. Tour Lab and see where things are
2. Send Dr. Ramsey and Kira overview of meeting this morning (sent 10/11)

Results and Data:
Main takeaways of meeting this morning:
Goal: streak bacterial plates to find more resistant bacteria and sequence them 
I will be
1. Trained
2. Streaking colonies for isolation that Kira found in resistant disk area
3. of those isolated colonies, restreak and run disk resistant experiment, see if colonies grow
4. Sequence colonies to see if they have the same mutation/are same bacteria or are the wild type that's hiding in there
5. Possibly cloning if there is time but most likely not. 
Wednesday, October 11 2023
To Do:
1. Pour LB Plates
2. Streak possibly resistant colonies for isolation
Results and Data:
General notes:
· heat water bath to 56C so its hot enough for media to melt but not hot enough for boil
· glycerol stocks should be frozen until being used
· list on google drive about plasmid names and if they are made and where -80 items are
· different samples are different strains (for instance KRB8 and KRB9 are two different strains)
· we are assuming that 8.1 and 8.2 come from same plate bc unsure
· Also done today: aliquoted 5mL samples of LB broth into individual tubes for inoculation with individual colonies tomorrow
· 
· FOR TOMORROW: pick single colonies (3) from each initial stock
· start growing in LB overnight (broth)
· next day (friday) make glycerol stock out of them
· next week (10/16) disk diffusion assay with select ones


[bookmark: _heading=h.pohpa3ol3jj1]Protocol Streaking for Isolation
1. Under flame
2. take out sample from -80C, only hold by cap. NOTES Samples done today: Glycerol stock KRSA 9A-1 and KRSA 8B-1. These samples were found in middle drawer B3 of -80 in a box labeled SA. Streaked onto LB Plate
3. per sample: using wooden stick take bit of sample
4. streak quadrant 1 of plate by taking a wooden stick with sample and going back and forth in forward motion down the quadrant. discard of stick after
5. new stick: streak quadrant 2. Take a new stick and starting in quadrant 1 take one or two lines and go back and forth into quadrant 2 in forward motion down quadrant. Discard stick.
6. new stick: streak quadrant 3. Take a new stick and starting in quadrant 2 take one or two lines and go back and forth into quadrant 3 in forward motion down quadrant. Discard stick.
7. new stick: streak quadrant 4. Take a new stick and starting in quadrant 3 take one or two lines and go back and forth into quadrant 4 in forward motion down quadrant. Discard stick.
8. Do for each sample (done in triplicate)
9. Put in incubator at 37C overnight

Thursday, October 12, 2023
To Do:
1. Find 3 isolated colonies from each plate from Oct 11, 2023
2. Inoculate 5mL LB with one colony from plate each
3. Store at 37C overnight

Results and Data:
· tubes were inoculated with one colony each. Each colony came from a different plate. for instance, in tube SA9A-1.1 came from plate SA9A-1.1
· The .1, .2, .3 after each name comes from the replicate number that it is (3 plates were made for each SA sample). 
· After inoculation, plates were parafilmed and put into 4C fridge, tubes were placed on shaking incubator at 37C
[bookmark: _heading=h.e5ayzeg2j3is][image: ]Streaked Plates of KRSA 9A-1 and KRSA 8B-1
Streaked plates of cultured bacteria KRSA 9A-1 and KRSA 8B-1. Cultures came from glycerol stock. Bacteria are thought to be PLRM (possible laurenbiolide resistant mutants). 

Friday, October 13, 2023
To Do:
1. Take cultures from incubator
2. Spin cultures down into glycerol stock
3. Spin remainder of culture into eppendorf cultures

[image: ][image: ]
[bookmark: _heading=h.l7p23ydqwjp7]Culture Tubes of KRSA9A-1 and KRSA8B-1
[bookmark: _heading=h.1pj8r65hn82s]Protocol Making Glycerol Stock
1. Label cryovials, two vials per stock. Names include KRSA (SA for staph aureus) the stock number (9A-1 or 8B-1) and then an extra .1# (for which plate they originally came from and the replicate of that plate).
a. for instance, there is a KRSA 9A-1.11 which stands for staph aureus, original stock 9A-1, the first replicate of that stock (.1) and the first replicate from that broth tube (.01). 
2. Using aseptic technique, aliquoted 200ul of 75% glycerol stock to each vial
3. Aseptic technique, add 800ul of culture to its corresponding cryovial
4. Cap, vortex, BRIEFLY spin down in baby microcentrifuge on bench
5. store at -80C
6. After glycerol stocks made, the culture left in the tube was pelleted by taking 1.5mL and putting in eppendorf tubes (with same label, one for each culture tube), centrifuged at max speed for one minute, supernatant discarded, repeated until all culture pelleted, stored at -80C in same box
Notes: 
· -80C box in 6E labeled Alex Farah Stocks
Monday, October 16, 2023
To Do:
1. Streak plates for isolation from glycerol stock. 2 plates from 9, 2 plates from 8, a WT resistant, and WT known sensitive on LB plates
2. Make 2 new LB agar flasks
3. Aliquot 24mL new LB plates
Notes/Things needed for disk diffusion assay: 
(don’t set up tomorrow, set up disk plates on wednesday) 
· plates (not LB from before bc bacteria are sensitive so we want an equal amount of volume in them, so we’re going to take 50ml pipette and put 24ml of LB agar into each plate). Pour as many plates as possible by aliquoting for one flask. make sure to move fast so it doesn’t solidify
· use all of the same plates for the disk diffusion
· don't use the same plates on the same day for disk diffusion assay. pour today do wednesday 
· using last week's LB plates, label, streak to single colony. (today)
· one plate per glycerol stock
· WT that's sensitive, strain that's resistant, glycerol stock colonies (2 from 9 and 2 from 8)
· tomorrow we will grow culture from one of these single colonies 
· look over extracting genomic dna protocol
· thursday: image the plates. plate into the gel doc system and take pictures. hold onto plates in case extra mutants pop up
· friday: measure. start to isolate genomic dna and depending on time use primers that amplify gene for bsl21 for targeted assessment of gene rspU on pcr. 
· -protocol folder. protocol, media, LB agar. make 2 maybe 3 (ask ben)
· strains used for streaking for isolation on 10/16/23: sensitive: KRSA1,known resistant KRSA4, and stocks made on friday KRSA 9A-1.1, 9A-1.2, 8B-1.1, 8B-1.2
[bookmark: _heading=h.htw8qgcydqx4]Protocol Making LB Agar
1. followed protocol in KRamsey folder protocols → media → LB agar
a. same amounts used for 500mL flask (6g agar (one had 6.01g), 5g NaCl (one had 5.03g), 5g tryptone, 2.5g yeast extract)
b. 2 500mL flasks were made
Tuesday, October 17, 2023
To Do:
1. look over extracting genomic DNA protocol
2. Aliquot 5mL of LB Media
3. Inoculate 5mL LB broth with single colony from Monday LB plates

Notes:
· KRSA 4 was smeary, probably plate was too wet. Was able to find single colony and grew broth from that.
· Inoculated cultures left on bench top 11:30 - , and then put into incubator at 37C overnight. optimal time 15-18 hours on incubator
[image: ]
[bookmark: _heading=h.m5xh066zmjmu]Streaked Plates of KRSA 1, 4, 9A-1.1, 9A-1.2, 8B-1.1, 8B-1.2

Wednesday, October 18, 2023
To Do:
1. Find OD of inoculated culture broths
2. Set up disk diffusion assay
Notes:
Protocol adapted from Dr. Ramsey and Kira. Protocols → Antibiotic MICS → Disk diffusion assay. 
[bookmark: _heading=h.35j1xv4l6acl]Protocol Disk Diffusion Assay
1. Pour fresh LB plates without antibiotics (24ml per plate) the day before DDA to have more consistent results
2. Liquid cultures can be started the night before. Measure the OD600:
a. Put 925 ul of LB into microcentrifuge tube and then 75 ul of the bacteria. We made 1:15 dilutions in this case. Normally, we do 1:20 dilutions, but the concentration of cells needed were to small pipette wise so we did 1:15. 
b. Remember that spec cuvettes are not sterile, so be sure to change pipets in between samples
c. Set up a blank with 1 ml LB
3. Adjust the concentration of cells for a final OD600 of 0.05. To do this, dilute the appropriate amount of culture in a 50 mL conical or serially dilute in 1.5ml tubes that contains LB media to get required OD600, for a final volume of 1 mL (Use C1V1=C2V2). To ensure accurate dilutions, do not pipette less than 20 uL of concentrated cells. Repeat steps 1 and 2 for each strain. 
4. For each strain being tested, aseptically add 100 µL each of S. aureus cells at OD600 0.05 to LB agar plates in triplicate and spread with glass beads. Allow plates to dry.
a. We did not think we had enough drug for triplicate so we did 1 pos control, 1 neg control, 2 samples from one culture, 2 samples from the other culture. 
5. Using sterile tweezers, add sterile filter paper discs to a sterile plate. On each disc, add 20 µL of either the liquid the antibiotic is resuspended in for the negative control or the  antimicrobial Used two plates, one for negative control (methanol), one for drug (Laurenobiolide). Be careful to not mix up the discs! Allow discs to dry for 20 minutes. Examples of drugs and diluents are listed below:
Drug					Dilutant
Laurenobiolide (8 mg/mL)		methanol
Kasugamycin (conc varies)		water

6. Using sterile tweezers, transfer dry discs from sterile plate to LB agar plates that have been spread with S. aureus. On each plate, place one control disc (on the side) and one antibiotic disc (in the center). Gently press them into plate without breaking the agar. Flame tweezers in between each disk. 
7. Incubate overnight at 37ºC. Flip plates upside down to be incubated like usual (agar on top). 
8. Image and analyze plates with ImageJ (see ImageJ protocol)

[bookmark: _heading=h.rd7w2fchrddc]Table 1
	OD600 Values of samples 1-6, dilutions made, and volume of starting culture to add to make 0.05OD to be added onto plates.
	 
	 
	Observed OD600
	Calculated OD600
	diluted OD600 (1:10)
	Desired OD600
	Desired volume
	Starting volume OD600 0.05 (ul)

	KRSA 1
	1
	0.474
	7.11
	0.711
	0.05
	1000
	70.3

	KRSA 4
	2
	0.457
	6.855
	0.6855
	0.05
	1000
	72.9

	KRSA 9A-1.1
	3
	0.548
	8.22
	0.822
	0.05
	1000
	60.8

	KRSA9A-1.2
	4
	0.413
	6.195
	0.6195
	0.05
	1000
	80.7

	KRSA8B-1.1
	5
	0.457
	4.57
	0.457
	0.05
	1000
	109.4

	KRSA8B-1.2
	6
	0.464
	4.64
	0.464
	0.05
	1000
	107.8



Thursday, October 19, 2023
To Do:
1. Image and analyze disk diffusion assay plates
[bookmark: _heading=h.lnxbz9]Protocol Using ImageJ

1. Open ImageJ
2. File>Open>20201125_measure.tif  (saved copy in Alex’s notebook)
3. Select [image: ] “Straight”
4. Using “Straight” line tool, measure 5 mm on the ruler (between 2 and 2.5cm), be as precise as possible. Make sure the dots are hitting the lines
5. File>Open>[your image file] Drag the file into imageJ. A dialog box might appear, if it does, uncheck ‘Disable Global Calibration’>OK
6. Click on ImageJ, MAKE SURE TO CLICK BACK ON THE RULER PICTURE
7. Analyze>Set Scale...
8. Under ’Known Distance’ type 5.0, under ‘Unit’ type mm, select the ‘Global’ checkbox.
9. Using Straight Line tool, measure the diameter of the zone of inhibition (draw a line from the edge of inhibition, through the disc, to another edge) 
10. Click Analyze>Measure 
11. While Measure dialogue is open you can draw two more diameters, clicking Measure after each to record the length
12. Copy lengths into an Excel spreadsheet  
13. Repeat with any other images


[bookmark: _heading=h.35nkun2]Figure: Zone of Inhibition for Potentially Resistant S. aureus Strains

Friday, October 20, 2023
To Do:
1. Plasmid primer design
Check Kira’s book for info

Monday, October 23, 2023
To Do:
1. gDNA extraction
2. PCR
3. purification
4. set up for sequencing
[bookmark: _heading=h.1ksv4uv]gDNA Extraction Protocol – S. aureus
Cell Samples
1. Dilute lysostaphin in Tissue and Cell Lysis Solution to 1 mg/mL (i.e. 30 ul of 10 mg/ml stock in 270 ul TCL)
2. Add lysozyme crystals to 1 mg/mL and dissolve by pipetting up and down.
	DUE TO CRYSTALS BEING WEIRD, WE MADE STOCK SOLUTION AND ADDED TISSUE AND CELL LYSIS SOLN TO LYSOSYME CRYSTALS TO LYSOSTAPHIN IN A BIG MASTER MIX
	component
	each
	Total (3.5x rxn)

	TCL
	270
	945

	Lysostaphin
	30
	105

	Lysozyme
	15
	52.5

	total
	315
	1102



3. Pellet 0.5 mL of an overnight culture by centrifugation and discard the supernatant, leaving approximately 25 µl of liquid. Done already. Starting here. 
4. Vortex for 10 seconds to resuspend the cell pellet. 
5. Add 300 ul of Tissue and Cell Lysis Solution containing the lysozyme and lysostaphin and mix thoroughly. WE DID 315ul BC MASTER MIX FOR CORRECT CONC
6. Incubate at 37°C for 30 minutes
7. Add 1 ul of Proteinase K to each sample and pipette up and down.
8. Incubate at 65°C for 15 minutes; vortex every 5 minutes. 
9. Cool the samples to 37°C and add 1 µl of 20 mg/ml RNase A to the sample; pipette up and down. 
10. Incubate at 37°C for 30 minutes. 
11. Place the samples on ice for 3-5 minutes and then proceed with total DNA precipitation (below).
Precipitation of Total DNA (for all biological samples) 
1. Add 150 µl of MPC Protein Precipitation Reagent to 300 µl of lysed sample and vortex vigorously for 10 seconds. 
2. Pellet the debris by centrifugation at 4°C for 10 minutes at ≥10,000 x g in a microcentrifuge. If the resultant pellet is clear, small, or loose, add an additional 25 µl of MPC Protein Precipitation Reagent, mix, and pellet the debris again. Should be obvious pellet. 
3. Transfer the supernatant to a clean microcentrifuge tube and discard the pellet. 
4. Add 500 µl of isopropanol to the recovered supernatant. Invert the tube 30-40 times. 
5. Pellet the DNA by centrifugation at 4°C for 10 minutes in a microcentrifuge. Cloudy pellet.
6. Carefully pour off the isopropanol without dislodging the DNA pellet. 
7. Add 1mL 70% ethanol to tube, then quickly remove and discard. Repeat with new 1mL of 70% ethanol. being careful to not dislodge the pellet. Centrifuge 1 min at 10000xg at 4°C if the pellet is dislodged. Remove all of the residual ethanol with a pipet and let dry completely under hood.
8. Resuspend the DNA in 35 µl of 0.1x EB Buffer. Put on ice to help dissolve, and add 50 µl of additional buffer if DNA is very goopy.
9. Check concentration and purity by nanodrop.

Nanodrop

	#
	Nucleic Acid
	Unit
	A260 (Abs)
	A280 (Abs)
	260/280
	260/230

	9A- 1.1
	113.6
	ng/µl
	2.272
	1.186
	1.91
	1.58

	9A – 1.2
	46
	ng/µl
	0.92
	0.432
	2.13
	1.86

	9A – 1.3
	124.7
	ng/µl
	2.494
	1.386
	1.8
	1.28




PCR:
	Reaction Number 
	Plasmid/Region
	Source DNA
	Primers
	Length (bps)

	1
	+ control rplU
	KRSA1 gDNA
	KROL675, KROL676
	547

	2
	rplU
	KRSA9-A-1.1 gDNA
	KROL675, KROL676
	547

	3
	rplU
	KRSA9-A-1.2 gDNA
	KROL675, KROL676
	547

	4
	rplU
	KRSA9-A-1.3 gDNA
	KROL675, KROL676
	547

	5
	- control
	Water
	KROL675, KROL676
	-



In reaction 3: 2ul of gDNA added due to low concentration nanodrop, 48ul of master mix added. 
	Total reaction volume
	50
	
	
	

	Total number of reactions
	5
	

	
	

	
	
	
	
	Factor

	Component
	Stock concentration
	Final concentration
	1 rxn volume
	6

	ddiH2O
	 
	 
	31.0
	186

	PrimeSTAR GXL Buffer
	5x
	1x
	10.0
	60

	dNTPs
	2.5 mM
	0.2 mM
	4.0
	24

	oligo F
	10 uM
	0.3 uM
	1.5
	9

	oligo R
	10 uM
	0.3 uM
	1.5
	9

	template
	100 ng/ul
	2 ng/ul
	1.0
	 

	PrimeSTAR GXL DNA Polymerase
	1.25 U/ul
	0.025 U/ul
	1.0
	6

	 
	 
	Total volume
	50
	294



Tuesday, October 24, 2023
To Do:
1. PCR Purification
2. set up for sequencing
3. Send out for sequencing
PCR Purification/Clean up Protocol 
From QIAquick PCR Purification Kit
All centrifuge steps at 13000rpm
1. Add 5 volumes Buffer PB to 1 volume PCR reaction and mix by pipette
2. Place a QIAquick column in a 2mL collection tube
3. Apply the sample to the QIAquick column and centrifuge for 60 seconds. Discard flow through and place collection tube back onto column
4. Add 750ul Buffer PE to column, centrifuge 60s, discard flow through and place column back in same tube
5. Centrifuge column for 3 mins to remove any leftover buffer
6. Place QIAquick column into clean 1.5ml microcentrifuge tube
7. Elute DNA by adding 50ul buffer 0.1xEB to center of membrane, let sit for one min, and centrifuge column for 1 min. 

After purification, nanodrop samples and set up sequencing
Nanodrop Results:
	Sample
	Concentration (ng/ul)

	WT KRSA 1
	58.6

	KRSA 9A-1.1
	162.2

	KRSA 9A-1.2
	65.2

	KRSA 9A-1.3
	71.6



Sequencing set up in:
Kramsey drive  sequencing  orders  20231024_ARF_sequencing_PRMS
Diluted samples 1:20 for samples 1, 3, 4. Diluted sample 2 1:25.

Wednesday, October 25, 2023
To Do:
1. In vitro assay for ribosome test

In Vitro Assay Protocol 

Protocol from Ben -- PureExpress Delta Ribosome Kit Protocol
 Set up PCR reaction tubes.
Tube Purpose
	Tube
	Purpose

	1
	No abx

	2
	Methanol

	3
	Thiostrepton (50uM)

	4
	Laurenobiolide high (45.8uM)

	5
	Laurenobiolide low (4.58uM)

	6
	DMSO

	7
	No ribosomes



 Thaw all components on ice. Pulse-spin in microfuge to collect solutions to bottom of
tubes. If Solution A has precipitates, mix well prior to assembling reaction. Do not vortex
Solution B.
· Solution A
· Factor Mix
· Phenol-chloroform purified pKR144
· Kit ribosomes
· Laurenobiolide
· Thiostrepton
 Dilute DNA in 0.1xEB to a concentration of 125 ng/uL.
	Sample
	Concentration (C1)
	Desired conc (c2)
	Desired volume (V2)
	Sample volume (V1)
	Buffer Volume

	Phenol:chloroform purified pKR144 diluted
	457.4ng/uL
	125ng/uL
	20uL
	5.47uL
	14.53uL



 Prepare stocks of Laurenobiolide, Thiostrepton, and DMSO
 Add components in the following order:
	Solution A
	10 uL

	Factor Mix
	3 uL

	Ribosomes
	5.62uL (59.85) pmol/reaction of 6/7 E. coli 2

	Template DNA
	2 uL (Phenol:chloroform purified pKR144)

	Treatment
	0.5uL

	Water
	8.88uL

	Total
	30 uL




	Tube
	Solution A
	Factor Mix
	Ribosomes
	DNA (125ng/uL)
	Treatment
	Water

	1
	10uL
	3uL
	5.62uL
	2uL
	-
	9.38uL

	2
	10uL
	3uL
	5.62uL
	2uL
	0.5uL Methanol
	8.88uL

	3
	10uL
	3uL
	5.62uL
	2uL
	0.5uL Thiostrpton
	8.88uL

	4
	10uL
	3uL
	5.62uL
	2uL
	0.5uL Laurenobiolide (45.8uM)
	8.88uL

	5
	10uL
	3uL
	5.62uL
	2uL
	0.5uL 1:110 Laurenobiolide (4.58uM)
	8.88uL

	6
	10uL
	3uL
	5.62uL
	2uL
	0.5uL DMSO
	8.88uL

	7
	10uL
	3uL
	-
	2uL
	-
	15uL



 Mix gently and pulse-spin in microfuge to collect mixture at the bottom of the tube
 Incubate at 37C for 2 hours in thermocycler
 Stop the reaction by placing tubes on ice.
 Freeze at -20C.
Nano-Glo® Luciferase Assay Protocol
 Prepare plate map and list samples and controls
[image: A screenshot of a computer screen

Description automatically generated]
 Thaw reactions on ice
 Thaw Nano-Glo® Luciferase Assay Buffer and Nano-Glo® Luciferase Assay Substrate
on ice – mix by pipetting
 Prepare appropriate volume of reconstituted reagent by combining 1 volume of
substrate with 50 volumes of buffer and mix by pipetting
o Add 2 to the number of reactions you will need to run, this will be the volume of
substrate
o Multiply this number by 50 to get volume of buffer
o For 450 uL of reagent mix 450 uL of buffer with 9 uL of substrate
 Bring 96-well plate, an aliquot of H10M10A50 buffer, the reconstituted reagent, a small
waste beaker, the flash drive, and the reactions on ice as well as a 200 uL pipettor and
tips to the plate reader
 Add reactions to designated wells
 Turn on the plate reader and wait for it to initialize
 Select appropriate protocol
 Add equal volume of assay substrate to reaction volume (30 uL) – mix by pipetting
 Set timer for 3 minutes
 Read the plate on the appropriate settings
Note: Ensure luminescence values remain within the linear range of 10^3 and 10^8
 Export data as Excel file and save to flash drive
 Save reactions in 1.5 mL microcentrifuge tubes in -20C for future Western blots
[image: A graph of blue bars with numbers and letters
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Figure: Results for In Vitro Assay

Notes about in vitro assay:
· Results showed that laurenobiolide did not inhibit protein translation at the low and high concentrations. The positive control of thiostrepton did, so we are able to use this assay in the future. We can try assay again with a higher concentration of laurenobiolide, or with s.aureus ribosomes 

Thursday, October 26, 2023
To Do:
1. Finish ppt

Friday, October 27, 2023
To Do:
1. Reconstitute new Primers

Reconstitute (Receiving) Primers Protocol
1. Spin primers at maximum speed in tabletop centrifuge for 3 minutes so desiccated primers go to the bottom of the tube.
2. Add 0.1x EB to a final concentration of 100 uM. Calculate this by multiplying the reported nm by 10 and adding that volume in ul (i.e. 12.7 nmoles = add 127 uL of 0.1xEB).
3. Put on 42°C heat block for 5 minutes to help primers dissolve
4. Vortex and brief spin.
5. Label tubes with KROL numbers on the top and put in the appropriate 100 uM stock box in the -20°C freezer.
6. Optional: Make dilution for intended purpose of primer. 
1. If a PCR primer, make a 10 uM stock by diluting 20 uL of the 100 uM stock into 180 uL of 0.1xEB. Label with purple sticker and put in appropriate freezer box.
2. If a sequencing primer, make a 2.5 uM stock by diluting 5 uL of the 100 uM stock into 195 uL of 0.1x EB. Label with blue sticker and put in appropriate freezer box.
7. Put Certificate of Analysis sheet in “Oligos Spec Sheet” binder and shipping sheet in Invoices box.
	Primer Name
	nmoles
	Volume (ul) of 0.1xEB added

	KROL677
	23.0
	230

	KROL678
	31.0
	310

	KROL679
	16.7
	167

	KROL680
	28.6
	286



Monday, October 30, 2023
To Do:
1. Validation on new Primers
2. Set up new primer PCR
3. Run new primer on agarose gel

PCR on new Primers: 
5 samples: 
	Reaction Number 
	Plasmid/Region
	Source DNA
	Primers
	Length (bps)

	1
	pos control
	WT gDNA
	KROL 419, 420
	1015

	2
	rplU
	WT gDNA
	KROL677, KROL678
	1000ish

	3
	rplU
	WT gDNA
	KROL679, KROL680
	500ish

	4
	neg control
	water
	KROL 677, 678
	 

	5
	- control
	Water
	KROL679, KROL680
	-



Master Mix for 6 rxn :
	Component
	Stock Conc
	Final Conc
	1 rxn volume
	Total rxn volume

	ddH20
	
	
	11.8
	70.8

	PrimeSTAR GXL BUFFER
	5x
	1x
	4
	24

	dNTPs
	2.5 mM
	0.2mM
	1.6
	9.6

	PrimeSTAR GXL DNA Polymerase
	1.25 U/uL
	0.025U/uL
	0.4
	2.4

	
	
	TOTAL
	
	120 / 6 = 17.8 each rxn



In each rxn 0.6uL of Forward Primer, 0.6uL of Reverse Primer, and 1uL of DNA template was added after Master Mix was aliquoted into tubes for total reaction volume of 20uL. 

PCR run on STN1 Protocol, with extension time of 1min. 
Then run on 1x agarose gel @ 109V for approx. 45 mins. 
Order:
Ladder,
Pos control
KROL 677/678
KROL 679/680
Neg control 677/678
Neg control 679/680
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[bookmark: _Hlk150102800]Figure: Gel Image for Primer KROL 677,678,679,680 Validation

Tuesday, October 31, 2023
To Do:
1. Higher volume PCR with new primers

PCR Set Up
	Total reaction volume
	100
	
	
	

	Total number of reactions
	5
	
	
	

	
	
	
	
	Factor

	Component
	Stock concentration
	Final concentration
	1 rxn volume
	6

	ddiH2O
	
	
	62.0
	372

	PrimeSTAR GXL Buffer
	5x
	1x
	20.0
	120

	dNTPs
	2.5 mM
	0.2 mM
	8.0
	48

	oligo F
	10 uM
	0.3 uM
	3.0
	18

	oligo R
	10 uM
	0.3 uM
	3.0
	18

	template
	100 ng/ul
	2 ng/ul
	2.0
	

	PrimeSTAR GXL DNA Polymerase
	1.25 U/ul
	0.025 U/ul
	2.0
	12

	
	
	Total volume
	100
	588



Set up and put into Thermocycler on STN1 with only deviation to protocol is an extension time of 1min. 
After run, put into freezer overnight. 
Wednesday November 1, 2023
To Do:
1. Make new 1x gel
2. Run PCR from yesterday on gel
3. PCR clean up 
4. New PCR (repeat bc of negative control) 

1 New PCR Gel made by mixing 1.0g of ultrapure agarose gel with 100mL 1x TAE buffer. Heated until boiling and mixed with stir bar then poured. 
2 Results from yesterdays PCR

Order:
Ladder,
Pos control
KROL 677/678
KROL 679/680
Neg control 677/678
Neg control 679/680
[image: A square object with a black background
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Figure: Gel Image for PCR from 10/31

When running yesterdays PCR on a gel, a slight band was seen in the negative control for KROL 679/680. New PCR was set up to see if contamination persists or if it was a mistake most likely due to not spinning down all components. 
3 Cleaned up PCR from 10/31 for KROL 677/678 according to PCR clean up protocol. 

4 A new PCR was done with KROL 679/680 to see if contamination persist. 
New PCR Set Up: 
	Total reaction volume
	100
	
	
	

	Total number of reactions
	3
	
	
	

	
	
	
	
	Factor

	Component
	Stock concentration
	Final concentration
	1 rxn volume
	4

	ddiH2O
	
	
	62.0
	248

	PrimeSTAR GXL Buffer
	5x
	1x
	20.0
	80

	dNTPs
	2.5 mM
	0.2 mM
	8.0
	32

	oligo F
	10 uM
	0.3 uM
	3.0
	12

	oligo R
	10 uM
	0.3 uM
	3.0
	12

	template
	100 ng/ul
	2 ng/ul
	2.0
	

	PrimeSTAR GXL DNA Polymerase
	1.25 U/ul
	0.025 U/ul
	2.0
	8

	
	
	Total volume
	100
	392



Thursday November 2, 2023
To Do:
1. Run gel of new PCR

[image: A white square with black lines
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Figure: Gel Image for PCR from 11/01 (Getting rid of contamination)
Order of gel image:
Positive control
KRSA 1 with primers 679/680
Negative control KROL 679/680
Contamination is now gone. PCR was cleaned up by Kira. 
Friday November 3, 2023
To Do:
1. Clean Up Lab things left over
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Zone of Inihibition for Potentially Resistant S. aureus Strains

Wildtype	R89P	KRSA9A-1.1	KRSA9A-1.2	KRSA8B-1.1	KRSA8B-1.2	Disc	13.516666666666667	8.0170000000000012	7.9543333333333335	7.9173333333333344	14.866	15.199333333333334	6.8706666666666676	Sample
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